
 

Computer Applications 

SEC-3, 4-Year Education Major 

L11: Text Formatting 

 

 

টেক্সে সম্পাদনা ও ফরম্যাটেিং 

(Bold, Italic, Underline, Font Type, Font Size, Alignment, 

Page Number, Bullets & Numbering) 

 

 



১. টেক্সে এডিটেিং (Editing Text) 

টেক্সে এডিটেিং হল ো িকুলেলের টেতলরর ট খো পডরবর্তন, সিংশ াধন, টেশে টনওযা, েডপ 

েরা, টপস্ট েরা অথবা মু্শে টফলা। 

Editing-এর সোধোরণ কোজগুল ো— 

 টেক্সে ডির্ বোচি (Select) 

 কডি করো (Ctrl + C) 

 কোে করো (Ctrl + X) 

 টিস্ট করো (Ctrl + V) 

 Undo (Ctrl + Z) 

 Redo (Ctrl + Y) 

 

২. Text Formatting েী? 

Formatting র্ লত ট খোর দৃটিনন্দন রূপ পডরবর্তন টর্োঝোয়—টেেি ফে িডরর্তবি, সোইজ টিক 

করো, Bold/Italic করো, রঙ টেোগ করো ইতযোডি। 

Format করো হল  িকুলেে আরও িডরষ্কোর ও িোিলেোগয হয়। 

 

৩. Text Style: Bold, Italic, Underline 

✔ (১) Bold (Ctrl + B) 

ট খো টেোেো কলর গুরুত্ব টর্োঝোলত র্যর্হৃত হয়। 

উিোহরণ: েম্পম্পউোর 

✔ (২) Italic (Ctrl + I) 

ট খোলক একেু ডতে বক কলর ফুটেলয় টতোল । 

উিোহরণ: কম্পিউেোর 

✔ (৩) Underline (Ctrl + U) 



ট খোর ডিলচ িোগ টেলি গুরুত্বিূণ ব অিংশ আ োিো কলর। 

উিোহরণ: কম্পিউেোর 

 

৪. Font Type (ফন্ট োইপ) 

ফে েোইি হল ো ট খোর স্টোই  র্ো আকৃডত। উিোহরণ: 

 Times New Roman 

 Arial 

 Kalpurush 

 SolaimanLipi 

ফে েোইি িডরর্তবি করলত: Home → Font → Font Name ডনব তাচন। 

 

৫. Font Size (ফন্ট সাইজ) 

ট খোর আকোর র্ড়/ট োে করলত র্যর্হোর করো হয়। 

সোধোরণত Title: 16–20, Body Text: 11–12। 

ফে সোইজ িডরর্তবি: Home → Font Size Box 

 

৬. Alignment (টলখার অবস্থান) 

Alignment হল ো িষৃ্ঠোর েলধয ট খোর ডিক ডিধ বোরণ। 

 Left Align (Ctrl + L): র্োে িোলশ সোজোলিো 

 Center Align (Ctrl + E): েোঝখোলি সোজোলিো 

 Right Align (Ctrl + R): িোি িোলশ সোজোলিো 

 Justify (Ctrl + J): চোরডিক সেোি টরলখ সুন্দর কলর সোজোলিো 

 

৭. Page Number ট াগ েরা 

িকুলেলে টিজ িম্বর টেোগ করল  িষৃ্ঠো গুল ো সটিক ক্রলে থোলক। 



িদ্ধডত: 

Insert → Page Number → Top/Bottom ডনব তাচন → OK 

 

৮. Bullets and Numbering 

Bullets এর্িং Numbering তোড কো ততডর করলত র্যর্হৃত হয়। 

✔ Bullets (●, ○, ✔) 

অডিয়ডেত তোড কোর জিয। 

✔ Numbering (1, 2, 3) 

ক্রেেুক্ত তোড কোর জিয। 

িদ্ধডত: 

Home → Paragraph → Bullets/Numbering 

 

৯. প্র্যােটেেযাল োস্ক (Practical Assignment) 

 

🧪 োস্ক–১: ফন্ট ও স্টাইল ফরম্যাটেিং 

1. MS Word খু ুি 

2. ডিলচর  োইিটে েোইি করুি— 

“Word Processor-এর ম্াধযশম্ টেক্সে এডিটেিং ও ফরম্যাটেিং ট খা গুরুত্বপূর্ ত।” 

3.  োইিটেলক Bold + Italic করুি 

4. ফে িডরর্তবি কলর Arial করুি 

5. ফে সোইজ 16 করুি 

 

🧪 োস্ক–২: Alignment োস্ক 



1. ৩টে র্োকয ড খুি 

2. প্রথেটে Left Align 

3. ডিতীয়টে Center 

4. তৃতীয়টে Justify কলর সোজোি 

 

🧪 োস্ক–৩: Bullets ও Numbering 

1. "কম্পিউেোর র্যর্হোর" ডশলরোিোলে Bullet তোড কো ততডর করুি (৩টে িলয়ে) 

2. "Word Formatting Steps" িোলে একটে Numbering তোড কো ততডর করুি (৫টে ধোি) 

 

🧪 োস্ক–৪: Page Number ট াগ েরা 

1. ২ িষৃ্ঠো ট খো ততডর করুি 

2. Insert → Page Number → Bottom Center ডির্ বোচি করুি 

 

🧪 োস্ক–৫: সমূ্পর্ ত িেুশম্ন্ট ফরম্যাে েরুন 

1. একটে ডশলরোিোে ডিি – "টেক্সে ফরেযোটেিং প্রযোকটেকযো " 

2. ডশলরোিোেটে 20 size এর্িং Bold + Center করুি 

3. ৬–৮  োইি র্ডি টেক্সে ড খুি 

4. একটে Bulleted list টেোগ করুি 

5. টিজ িম্বর ডিি 

6. িকুলেেটে Formatting_Practical.docx িোলে টসে করুি 

 

উপসিংহার 

টেক্সে এডিটেিং এর্িং ফরেযোটেিং হল ো ওয়োিব প্রলসডসিং-এর ডেডি। ফে, স্টোই , এ োইিলেে, 

রু্ল ে/িোম্বোডরিং এর্িং টিজ িম্বলরর সটিক র্যর্হোর একটে িকুলেেলক টিশোিোর ও সুন্দর কলর 

টতোল । ডিয়ডেত অিুশী িই িক্ষতো র্োড়োয়। 

 
 



 

 

 

 

🧪 Viva Questions (বািংলা) 

Topic: Edit and Format Text in a Word Processor 

 

🧪 পােত–A: টম্ৌডলে (Basic Level) 

1. টেক্সে এডিটেিং র্ লত কী টর্োঝোয়? 

2. ফরেযোটেিং (Formatting) কী? 

3. Bold, Italic এর্িং Underline-এর কোজ কী? 

4. Bold করোর শেবকোে কী? 

5. Italic করোর শেবকোে কী? 

6. Underline করোর শেবকোে কী? 

7. Font Type র্ লত কী টর্োঝোয়? 

8. Font Size টকি র্যর্হোর করো হয়? 

9. Alignment কোলক র্ল ? 

10. Left, Center, Right এর্িং Justify-এর কোজ কী? 

 

🧪 পােত–B: ম্ধযম্ স্তশরর ভাইভা প্র্শ্ন 

(Intermediate Level) 

11. Word-এ ফে িডরর্তবলির ধোিগুল ো র্ল ো। 

12. সোধোরণত Title এর্িং Body Text-এর জিয টকোি Font Size র্যর্হোর করো হয়? 

13. Paragraph Alignment টকোথোয় িোওয়ো েোয়? 

14. Bullets ও Numbering-এর েলধয িোথ বকয কী? 

15. Page Number টেোগ করলত টকোি টেিু র্যর্হোর করো হয়? 

16. Word-এ Insert Tab-এর কোজ কী? 

17. Justify Alignment কখি র্যর্হোর করো হয়? 

18. Bulleted List কী? 



19. Numbered List কী? 

20. Ribbon Menu র্ লত কী টর্োঝোয়? 

 

🧪 পােত–C: অযাডিশে ন টলশভল প্র্শ্ন 

(Applied Level) 

21. কীেোলর্ একটে Heading-টক Bold, Center এর্িং র্ড় Font Size টিলর্? 

22. অিুলেিলক Justify করল  কী সুডর্ধো হয়? 

23. Word Document-এ page number টকোথোয় র্সোলিো েোয়? 

24. Bullets র্যর্হোর কলর একটে তোড কো ততডর করোর ধোি র্ল ো। 

25. Numbering টেোগ করোর িলর ডকেোলর্ িডরর্তবি করো েোয়? 

26. Font Style এর্িং Font Effect ডক একই? টকি? 

27. Text Highlight Color-এর র্যর্হোর কী? 

28. Line Spacing িডরর্তবি করোর ধোি র্ল ো। 

29. েডি ট খোর ফে অলিক র্ড় র্ো ট োে হলয় েোয়, কীেোলর্ টিক করলর্? 

30. Different fonts র্যর্হোর করল  িকুলেে টিখলত টকেি েলি হয়? 

 

🧪 পােত–D: Higher-Order Thinking (সম্সযা 

সম্াধানমূ্লে প্র্শ্ন) 

31. ডশলরোিোে ও র্ডি টেক্সে একইেোলর্ টিখোল  কী সেসযো হয়? 

32. েু  Alignment িকুলেলের Presentation-এ কী প্রেোর্ টফল ? 

33. টর্ডশ রঙ র্ো অডতডরক্ত ফরেযোটেিং র্যর্হোর করল  িকুলেলের িোিলেোগযতো 

কীেোলর্ প্রেোডর্ত হয়? 

34.  Word িকুলেলে Formatting এর্িং Editing-এর েলধয েূ  িোথ বকয কী? 

35.  Justify Alignment সর্ ধরলির ট খোর জিয উিেুক্ত ডক? টকি? 

36. র্ড় িকুলেলে Page Number িো ডিল  কী সেসযো হলত িোলর? 

37. Bullets এর্িং Numbering তোড কো টকি ডরলিোেব র্ো টিোলে র্যর্হোর করো হয়? 

38. েডি েু র্শত Numbering েু  ফরেযোলে চল  আলস, কীেোলর্ টিক করলর্? 

39. Font Type েু েোলর্ ডির্ বোচি করল  িকুলেলের টিশোিোডরলত্ব কী প্রেোর্ িলড়? 

40. Word-এ Formatting Toolbar-এর গুরুত্ব কী? 



41. একটে Heading টক টর্ডশ প্রকোশ করলত হল  টকোি টকোি Formatting র্যর্হোর 

করো েোয়? 

42. ডকেোলর্ র্ুঝলর্ টকোলিো টেক্সলে Hidden Formatting আল  ডকিো? 

43. Bulleted তোড কোর Bullet Symbol িডরর্তবি করোর িদ্ধডত কী? 

44. Page Number টকোথোয় টকোথোয় র্সোলিো েোয়? িুটে উিোহরণ িোও। 

45. Header ও Footer-এর েলধয িোথ বকয কী? 

46. Formatting িো করল  একটে িকুলেে টকেি টিখোয়? 

47. Font Size এর্িং Text Zoom ডক একই জজডিস? র্যোখযো কলরো। 

48. েডি টকোলিো ট খোর অিংশলক আকর্ বণীয় করলত চোও—টকোি ডতিটে Formatting 

েু  র্যর্হোর করলর্? 

49. Text Alignment েু েোলর্ করল  ডপ্রে আউে টকি খোরোি টিখোয়? 

50. Bullets/Numbering ডিলয় ততডর তোড কো কীেোলর্ এক ডিলকই র্ন্ধ করো েোয়? 

51. Line Spacing কী? ট খোর টসৌন্দলে ব এর েূডেকো কী? 

52. Paragraph Formatting এর্িং Character Formatting-এর িোথ বকয র্ল ো। 

53. Page Number-এর সোলথ Chapter Number টেোগ করো ডক সম্ভর্? কীেোলর্? 

54. টকোি টকোি টক্ষলে Center Alignment র্যর্হোর করো উডচত? 

55. কখি Justify Alignment র্যর্হোর করো উডচত িয়? 

56. Word িকুলেলে “Page Layout” কী কোলজ  োলগ? 

57. Text Highlight Color এর্িং Font Color-এর েলধয িোথ বকয র্যোখযো কলরো। 

58. Default Font িডরর্তবি করল  েডর্র্যলতর িকুলেলে কী প্রেোর্ িলড়? 

59. েডি তুডে একটে প্রলজক্ট ডরলিোেব ততডর কলরো—Heading, Subheading ও Body 

Text-এর জিয টকোি formatting র্যর্হোর করলর্? 

60. Word Processing টশখো একজি ডশক্ষোথীর জিয টকি গুরুত্বিূণ ব? 

 

 
 

🧪 Viva Answers (Questions 1–32) 

Topic: Edit & Format Text (B, I, U, Font, Alignment, Page 

Number, Bullets/Numbering) 

 

🧪 পােত–A: টম্ৌডলে প্র্শ্ন ও উত্তর (১–১০) 



১. টেক্সে এডিটেিং বলশর্ েী টবাঝায? 

ট খোলক িডরর্তবি করো, কোেো, কডি করো, টিস্ট করো র্ো সিংলশোধি করো। 

 

২. ফরম্যাটেিং (Formatting) েী? 

ট খোর টচহোরো র্ো রূি িডরর্তবি করো—টেেি ফে, সোইজ, রঙ, স্টোই  ইতযোডি। 

৩. Bold, Italic এবিং Underline-এর োজ েী? 

 Bold: ট খোলক টেোেো কলর তুল  ধলর। 

 Italic: ট খোলক ডতে বক কলর। 

 Underline: ট খোর ডিলচ িোগ টিয়। 

৪. Bold েরার  েতোে েী? 

Ctrl + B 

৫. Italic েরার  েতোে েী? 

Ctrl + I 

৬. Underline েরার  েতোে েী? 

Ctrl + U 

৭. Font Type বলশর্ েী টবাঝায? 

ট খোর ধরি র্ো স্টোই , টেেি Arial, Times New Roman। 

৮. Font Size টেন বযবহার েরা হয? 

ট খোর আকোর র্ড় র্ো ট োে করোর জিয। 

৯. Alignment োশে বশল? 

ট খোলক র্োে, িোি, েোঝখোলি র্ো সেোিেোলর্ সোজোলিোলক Alignment র্ ো হয়। 

১০. Left, Center, Right এবিং Justify-এর োজ েী? 



 Left: র্োে ডিলক সোজোলিো 

 Center: েোঝখোলি 

 Right: িোিডিলক 

 Justify: চোরডিক সেোিেোলর্ সোজোলিো 

 

🧪 পােত–B: ম্ধযম্ স্তশরর উত্তর (১১–২০) 

১১. Word-এ ফন্ট পডরবর্তশনর ধাপগুশলা বশলা। 

Home → Font → Font Name ডির্ বোচি। 

১২. Title এবিং Body Text-এর জনয টোন Font Size বযবহার হয? 

Title: 16–20 

Body: 11–12 

১৩. Paragraph Alignment টোথায পাওযা  ায? 

Home Tab → Paragraph Group। 

১৪. Bullets ও Numbering-এর ম্শধয পাথ তেয েী? 

 Bullets: অ-ক্রেেুক্ত তোড কো 

 Numbering: ক্রেেুক্ত তোড কো 

১৫. Page Number ট াগ েরশর্ টোন টম্নু বযবহৃর্ হয? 

Insert → Page Number 

১৬. Insert Tab-এর োজ েী? 

 ডর্, টেডর্ , টশি, টহিোর/ফুেোর, টিজ িোম্বোর ইতযোডি টেোগ করো। 

১৭. Justify Alignment েখন বযবহার েরা হয? 

র্ড় অিুলেিলক সুন্দর ও েোরসোেযিূণ বেোলর্ সোজোলত। 

১৮. Bulleted List েী? 



ডচহ্ন (•, ✔) র্যর্হোর কলর ততডর তোড কো। 

১৯. Numbered List েী? 

সিংখযো (1, 2, 3...) র্যর্হোর কলর ততডর তোড কো। 

২০. Ribbon Menu বলশর্ েী টবাঝায? 

Word-এর উিলরর অিংশ টেখোলি সর্ েযোর্, েু  ও আইকি থোলক। 

 

🧪 পােত–C: অযাডিশে ন টলশভল উত্তর (২১–

৩০) 

২১. েীভাশব এেটে Heading-টে Bold, Center এবিং বড় Font Size টদশব? 

Heading ডির্ বোচি → Ctrl+B → Home → Center → Font Size র্োড়োলিো। 

২২. অনুশেদশে Justify েরশল েী সুডবধা হয? 

ট খো চোরডিলক সেোিেোলর্  ড়োয় এর্িং িড়লত সুন্দর  োলগ। 

২৩. Word Document-এ page number টোথায বসাশনা  ায? 

Header র্ো Footer-এ। 

২৪. Bullets ডদশয র্াডলো তর্ডর েরার ধাপ: 

Home → Bullets → Bullet Style ডির্ বোচি। 

২৫. Numbering ভুল হশল েীভাশব টিে েরশব? 

Numbering dropdown → Set Numbering Value র্ো Define New Number Format। 

২৬. Font Style এবিং Font Effect ডে এেই? টেন? 



িো। 

Font Style হল ো Bold, Italic ইতযোডি। 

Font Effect হল ো Shadow, Outline, Glow ইতযোডি। 

১৭. Text Highlight Color-এর বযবহার েী? 

ট খোলক ডর্লশর্েোলর্ ডচডহ্নত করলত টি লি রঙ টিওয়ো। 

২৮. Line Spacing পডরবর্তন েরার ধাপ বশলা। 

Home → Paragraph → Line Spacing। 

২৯. টলখার ফন্ট বড় বা টোে হশয টগশল েীভাশব টিে েরশব? 

Font Size dropdown টথলক সোইজ টিক করো। 

৩০. ডবডভন্ন font বযবহার েরশল িেুশম্ন্ট টেম্ন টদখায? 

অলগো োল ো, অসঙ্গত এর্িং কে টিশোিোর টিখোয়। 

 

🧪 পােত–D: উচ্চর্র প্র্শ্ন (৩১–৩২) 

৩১. ড শরানাম্ ও বডি টেক্সে এেইভাশব টদখাশল েী সম্সযা হয? 

ডেজযুয়ো  হোয়োরোডকব িষ্ট হয়, িোিক রু্ঝলত িোলর িো টকোিেো গুরুত্বিূণ ব। 

৩২. ভুল Alignment িেুশম্শন্টর Presentation-এ েী প্র্ভাব টফশল? 

ট খো অসেোি টিখোয়, িড়লত অসুডর্ধো হয় এর্িং টিশোিোডরত্ব িষ্ট হয়। 

 

🧪 Viva Questions with Answers (৩৩–৬০) 

 

৩৩. টবড  রঙ বা অডর্ডরক্ত ফরম্যাটেিং বযবহার েরশল িেুশম্শন্টর 

পািশ াগযর্া েীভাশব প্র্ভাডবর্ হয? 



অডতডরক্ত রঙ ও ফরেযোটেিং ট খোলক অলগো োল ো কলর, টচোলখ চোি টফল  এর্িং েূ  ডর্র্য়র্স্তু 

টথলক েলিোলেোগ সডরলয় টিয়। 

 

৩৪. Word িেুশম্শন্ট Formatting এবিং Editing-এর ম্শধয ম্ূল পাথ তেয েী? 

 Editing: ট খো িডরর্তবি/সিংলশোধি (Cut, Copy, Paste, Delete)। 

 Formatting: ট খোর রূি িডরর্তবি (Font, Size, Color, Alignment)। 

 

৩৫. Justify Alignment সব ধরশনর টলখার জনয উপ ুক্ত ডে? টেন? 

িো। র্ড় অিুলেলির জিয উিেুক্ত, ডকন্তু ট োে  োইলি অডতডরক্ত ফোাঁক টিখো েোয়। 

 

৩৬. বড় িেুশম্শন্ট Page Number না ডদশল েী সম্সযা হশর্ পাশর? 

িষৃ্ঠো গুল োর সটিক ক্রে টর্োঝো েোয় িো, িড়লত ও ডপ্রে সোজোলত অসুডর্ধো হয়। 

 

৩৭. Bullets এবিং Numbering র্াডলো টেন ডরশপােত বা টনাশে বযবহার েরা হয? 

তথযগুল ো িডরষ্কোর, সোজোলিো এর্িং দ্রতু িড়োর উিলেোগী করোর জিয র্যর্হৃত হয়। 

 

৩৮.  ডদ ভুলব র্ Numbering ভুল ফরম্যাশে চশল আশস, েীভাশব টিে েরশব? 

Numbering-এ ডিক → Define New Number Format → সটিক স্টোই  ডির্ বোচি। 

 

৩৯. Font Type ভুলভাশব ডনব তাচন েরশল িেুশম্শন্টর টপ াদাডরশত্ব েী প্র্ভাব 

পশড়? 

অিুিেুক্ত র্ো অডত-সোজোলিো ফে িকুলেেলক অপ্রলফশিো  ও কে িোিলেোগয কলর টতোল । 

 



৪০. Word-এ Formatting Toolbar-এর গুরুত্ব েী? 

এটে দ্রতু Bold, Italic, Font Size, Color, Alignment, Bullets ইতযোডি প্রলয়োগ করলত সোহোেয কলর। 

 

৪১. এেটে Heading টে টবড 目প্র্ো  েরশর্ হশল টোন টোন Formatting 

বযবহার েরা  ায? 

Bold, Bigger Font Size, Center Alignment, Underline র্ো Highlight। 

 

৪২. ডেভাশব বুঝশব টোশনা টেক্সশে Hidden Formatting আশে ডেনা? 

Home → ¶ (Show/Hide) ডচহ্ন চো  ুকরল   ুকোলিো formatting টিখোয়। 

 

৪৩. Bulleted র্াডলোর Bullet Symbol পডরবর্তন েরার পদ্ধডর্ েী? 

Bullets → Dropdown → Define New Bullet → Symbol র্ো Picture ডির্ বোচি। 

 

৪৪. Page Number টোথায টোথায বসাশনা  ায? দটুে উদাহরর্ দাও। 

 Page Top (Header) 

 Page Bottom (Footer) 

 

৪৫. Header ও Footer-এর ম্শধয পাথ তেয েী? 

 Header: িষৃ্ঠোর উিলরর অিংশ 

 Footer: িষৃ্ঠোর ডিলচর অিংশ 

 

৪৬. Formatting না েরশল এেটে িেুশম্ন্ট টেম্ন টদখায? 

একলেলয়, অলগো োল ো এর্িং িড়লত অসুডর্ধোজিক। 



 

৪৭. Font Size এবিং Text Zoom ডে এেই জজডনস? বযাখযা েশরা। 

িো। 

 Font Size: ট খোর প্রকৃত আকোর র্ি োয়। 

 Zoom: শুধু জিলি র্ড়/ট োে টিখোয়, ফোইল র আকোর র্ি োয় িো। 

 

৪৮. টোশনা টলখার অিং শে আের্ তর্ীয েরশর্ চাও—টোন ডর্নটে Formatting 

েুল বযবহার েরশব? 

Bold, Highlight, Larger Font Size। 

 

৪৯. Text Alignment ভুলভাশব েরশল ডপ্র্ন্ট আউে টেন খারাপ টদখায? 

ট খো অসেোি র্ো একডিলক ঝুল  েোয়, িুলরো িষৃ্ঠোর র্যো োন্স িষ্ট হয়। 

 

৫০. Bullets/Numbering ডদশয তর্ডর র্াডলো েীভাশব এে ডিশেই বন্ধ েরা 

 ায? 

Bullets/Numbering র্োেলি আর্োর ডিক করল  তো র্ন্ধ হলয় েোয়। 

 

৫১. Line Spacing েী? টলখার টসৌন্দশ ত এর ভূডম্ো েী? 

 োইিগুল োর েলধযকোর ফোাঁক। 

সটিক Line Spacing ট খোলক আরও স্পষ্ট ও আরোেিোয়ক কলর। 

 

৫২. Paragraph Formatting এবিং Character Formatting-এর পাথ তেয বশলা। 

 Paragraph Formatting: Alignment, Line Spacing, Indentation 

 Character Formatting: Font, Size, Color, Bold, Italic 



 

৫৩. Page Number-এর সাশথ Chapter Number ট াগ েরা ডে সম্ভব? েীভাশব? 

হযো াঁ। 

Insert → Page Number → Format → Include Chapter Number। 

 

৫৪. টোন টোন টেশে Center Alignment বযবহার েরা উডচর্? 

Heading, Title Page, Certificate Text, Short captions ইতযোডির টক্ষলে। 

 

৫৫. েখন Justify Alignment বযবহার েরা উডচর্ নয? 

খুর্ ট োে অিুলেি র্ো ২–৩  োইলির ট খোয়, কোরণ অি্েুত ফোাঁক ততডর হয়। 

 

৫৬. Word িেুশম্শন্ট “Page Layout” েী োশজ লাশগ? 

Margin, Orientation, Page Size, Columns টসে করলত। 

 

৫৭. Text Highlight Color এবিং Font Color-এর ম্শধয পাথ তেয বযাখযা েশরা। 

 Font Color: ট খোর রঙ িডরর্তবি কলর 

 Highlight Color: ট খোর টি লি রঙ টিয় (েোকবোর-এর েলতো) 

 

৫৮. Default Font পডরবর্তন েরশল ভডবর্যশর্র িেুশম্শন্ট েী প্র্ভাব পশড়? 

িরর্তী সর্ িতুি িকুলেে টসই ফলেই ততডর হলর্। 

 

৫৯. এেটে প্র্শজক্ট ডরশপােত  তর্ডর েরশর্ Heading, Subheading ও Body Text-

এর জনয টোন formatting বযবহার েরশব? 



 Heading: Bold + 18–20 Size + Center 

 Subheading: Bold + 14–16 Size 

 Body Text: 11–12 Size + Justify 

 

৬০. Word Processing ট খা এেজন ড োথীর জনয টেন গুরুত্বপূর্ ত? 

কোরণ এটে ডরলিোেব ট খো, টিোে ততডর, প্রলজক্ট ততডর, অযোসোইিলেে প্রস্তুডত ও টিশোিোর িকুলেে 

ততডরর জিয অতযোর্শযক িক্ষতো। 
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	52. Paragraph Formatting এবং Character Formatting-এর পার্থক্য বলো।
	53. Page Number-এর সাথে Chapter Number যোগ করা কি সম্ভব? কীভাবে?
	54. কোন কোন ক্ষেত্রে Center Alignment ব্যবহার করা উচিত?
	55. কখন Justify Alignment ব্যবহার করা উচিত নয়?
	56. Word ডকুমেন্টে “Page Layout” কী কাজে লাগে?
	57. Text Highlight Color এবং Font Color-এর মধ্যে পার্থক্য ব্যাখ্যা করো।
	58. Default Font পরিবর্তন করলে ভবিষ্যতের ডকুমেন্টে কী প্রভাব পড়ে?
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	60. Word Processing শেখা একজন শিক্ষার্থীর জন্য কেন গুরুত্বপূর্ণ?

	🎤 Viva Answers (Questions 1–32)
	Topic: Edit & Format Text (B, I, U, Font, Alignment, Page Number, Bullets/Numbering)

	🔹 পার্ট–A: মৌলিক প্রশ্ন ও উত্তর (১–১০)
	১. টেক্সট এডিটিং বলতে কী বোঝায়?
	২. ফরম্যাটিং (Formatting) কী?
	৩. Bold, Italic এবং Underline-এর কাজ কী?
	৪. Bold করার শর্টকাট কী?
	৫. Italic করার শর্টকাট কী?
	৬. Underline করার শর্টকাট কী?
	৭. Font Type বলতে কী বোঝায়?
	৮. Font Size কেন ব্যবহার করা হয়?
	৯. Alignment কাকে বলে?
	১০. Left, Center, Right এবং Justify-এর কাজ কী?

	🔹 পার্ট–B: মধ্যম স্তরের উত্তর (১১–২০)
	১১. Word-এ ফন্ট পরিবর্তনের ধাপগুলো বলো।
	১২. Title এবং Body Text-এর জন্য কোন Font Size ব্যবহার হয়?
	১৩. Paragraph Alignment কোথায় পাওয়া যায়?
	১৪. Bullets ও Numbering-এর মধ্যে পার্থক্য কী?
	১৫. Page Number যোগ করতে কোন মেনু ব্যবহৃত হয়?
	১৬. Insert Tab-এর কাজ কী?
	১৭. Justify Alignment কখন ব্যবহার করা হয়?
	১৮. Bulleted List কী?
	১৯. Numbered List কী?
	২০. Ribbon Menu বলতে কী বোঝায়?

	🔹 পার্ট–C: অ্যাপ্লিকেশন লেভেল উত্তর (২১–৩০)
	২১. কীভাবে একটি Heading-কে Bold, Center এবং বড় Font Size দেবে?
	২২. অনুচ্ছেদকে Justify করলে কী সুবিধা হয়?
	২৩. Word Document-এ page number কোথায় বসানো যায়?
	২৪. Bullets দিয়ে তালিকা তৈরি করার ধাপ:
	২৫. Numbering ভুল হলে কীভাবে ঠিক করবে?
	২৬. Font Style এবং Font Effect কি একই? কেন?
	১৭. Text Highlight Color-এর ব্যবহার কী?
	২৮. Line Spacing পরিবর্তন করার ধাপ বলো।
	২৯. লেখার ফন্ট বড় বা ছোট হয়ে গেলে কীভাবে ঠিক করবে?
	৩০. বিভিন্ন font ব্যবহার করলে ডকুমেন্ট কেমন দেখায়?

	🔹 পার্ট–D: উচ্চতর প্রশ্ন (৩১–৩২)
	৩১. শিরোনাম ও বডি টেক্সট একইভাবে দেখালে কী সমস্যা হয়?
	৩২. ভুল Alignment ডকুমেন্টের Presentation-এ কী প্রভাব ফেলে?

	🎤 Viva Questions with Answers (৩৩–৬০)
	৩৩. বেশি রঙ বা অতিরিক্ত ফরম্যাটিং ব্যবহার করলে ডকুমেন্টের পাঠযোগ্যতা কীভাবে প্রভাবিত হয়?
	৩৪. Word ডকুমেন্টে Formatting এবং Editing-এর মধ্যে মূল পার্থক্য কী?
	৩৫. Justify Alignment সব ধরনের লেখার জন্য উপযুক্ত কি? কেন?
	৩৬. বড় ডকুমেন্টে Page Number না দিলে কী সমস্যা হতে পারে?
	৩৭. Bullets এবং Numbering তালিকা কেন রিপোর্ট বা নোটে ব্যবহার করা হয়?
	৩৮. যদি ভুলবশত Numbering ভুল ফরম্যাটে চলে আসে, কীভাবে ঠিক করবে?
	৩৯. Font Type ভুলভাবে নির্বাচন করলে ডকুমেন্টের পেশাদারিত্বে কী প্রভাব পড়ে?
	৪০. Word-এ Formatting Toolbar-এর গুরুত্ব কী?
	৪১. একটি Heading কে বেশি目প্রকাশ করতে হলে কোন কোন Formatting ব্যবহার করা যায়?
	৪২. কিভাবে বুঝবে কোনো টেক্সটে Hidden Formatting আছে কিনা?
	৪৩. Bulleted তালিকার Bullet Symbol পরিবর্তন করার পদ্ধতি কী?
	৪৪. Page Number কোথায় কোথায় বসানো যায়? দুটি উদাহরণ দাও।
	৪৫. Header ও Footer-এর মধ্যে পার্থক্য কী?
	৪৬. Formatting না করলে একটি ডকুমেন্ট কেমন দেখায়?
	৪৭. Font Size এবং Text Zoom কি একই জিনিস? ব্যাখ্যা করো।
	৪৮. কোনো লেখার অংশকে আকর্ষণীয় করতে চাও—কোন তিনটি Formatting টুল ব্যবহার করবে?
	৪৯. Text Alignment ভুলভাবে করলে প্রিন্ট আউট কেন খারাপ দেখায়?
	৫০. Bullets/Numbering দিয়ে তৈরি তালিকা কীভাবে এক ক্লিকেই বন্ধ করা যায়?
	৫১. Line Spacing কী? লেখার সৌন্দর্যে এর ভূমিকা কী?
	৫২. Paragraph Formatting এবং Character Formatting-এর পার্থক্য বলো।
	৫৩. Page Number-এর সাথে Chapter Number যোগ করা কি সম্ভব? কীভাবে?
	৫৪. কোন কোন ক্ষেত্রে Center Alignment ব্যবহার করা উচিত?
	৫৫. কখন Justify Alignment ব্যবহার করা উচিত নয়?
	৫৬. Word ডকুমেন্টে “Page Layout” কী কাজে লাগে?
	৫৭. Text Highlight Color এবং Font Color-এর মধ্যে পার্থক্য ব্যাখ্যা করো।
	৫৮. Default Font পরিবর্তন করলে ভবিষ্যতের ডকুমেন্টে কী প্রভাব পড়ে?
	৫৯. একটি প্রজেক্ট রিপোর্ট তৈরি করতে Heading, Subheading ও Body Text-এর জন্য কোন formatting ব্যবহার করবে?
	৬০. Word Processing শেখা একজন শিক্ষার্থীর জন্য কেন গুরুত্বপূর্ণ?


